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In today's era of technology, there are an abundant variety of integrated 

sensors which range in a variety of low-cost sensors, which has encouraged the 

demand for more advanced sensor performance. This thesis describes the 

sensor in a much more detailed view which is the BME688 - which is capable of 

sensing gas, pressure, humidity, and air quality. Followng to it, a project based 

description on BME688 which inlcudes various hardware and software 

components which highlights the use of the sensor.  

The implementation of the project started from the hardware side comprising of 

building the circuit, by connecting the ESP32 microcontroller with the BME688 

sensor with male-female jump wires. Simultaneously, working on the software 

side by integrating Raspberry Pi with the computer to download MQTT 

Mosquitto Broker and Node-RED dashboard, through PuTTY software to keep 

the files and data encrypted.  

After the completion of the thesis project, all the published data were adequate, 

the implementation done on the hardware side was also working efficiently, and 

getting the right results in the correct range was also been observed. All the 

hardware components were showing the best abilities to communicate with 

each other. Discussing the software side, that was also very compatible and so 

the data communication throughout the project was implemented easily. 
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1 Introduction  

In today’s rapid growth of technologies, various kinds of sensors have been built 

and implemented to fetch data. As time has passed the focus has been more on 

the accuracy of sensing the data. These sensors could be found everywhere, 

the whole world is full of sensors and their applications. Ranging from your 

mobile phones to smart homes all the devices are sensors, which transmit the 

data at a defined interval of time. Sensors could be categorized by various 

characteristics such as applications, the material used, energy consumption, 

cost, etc.  

The main idea of this thesis is to communicate data using MQTT with BME688 

sensor, which is been connected to the ESP32 microcontroller followed by 

Raspberry Pi working on the backend side of the project. The project would be 

following an MQTT protocol built in a Pub - Sub model with an established 

MQTT broker which creates a bridge between the transmitter and receiver while 

the sensor is in its working stage. The final data collected would be displayed in 

a Node-Red dashboard, programmed in Arduino IDE. Specifically choosing 

BME688 Gas sensor for this project as it  is capable for sensing Gas, Humidity 

and Pressure, which gives more options in it’s applications. All the terms and 

concepts would be explained in more detail in further theis review. 

At the end, the thesis literature review is been divided into 5 chapters each 

explaning the concepts used in this project in a detailed information.  

The first chapter gives an introduction about the thesis idea and following to that 

a thesis overview. Having an aim of illustrating all the complexities in a 

understandable manner. 

Second chapter gives a light on the hardware and software side of the project 

which was used during the project. Giving all the technical knowledge and 

expertise by explaining it more with pin layout diagram and screenshots of 

downloading and using the software for the other side of the project. 
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Third chapter is the implementation where all the approach and ideas are been 

discussed, and then executed.  

Fourth chapter shares the results occurred while testing it throughout the 

process.  

Fifth chapter concludes the thesis.  
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2 Hardware and Software side of the project   

This project comprises of two sections, hardware and software. In the hardware 

side of the project many components are been used such as ESP-32, 

Raspberry Pi, BME688 gas sensor, breadboard, jumpwires, ethernet cable, etc. 

On the other section in the software side many softwares, dashboards, IDE 

were been used. All the mentioned technologies above will be explained in 

detailed view in the upcoming chapters.  

2.1 ESP32   

ESP-32 which is created by Espressif Systems is an SoC microcontroller 

loaded with various modules which are Low-cost and Low in power 

consumption. ESP-32 is the next generation of ESP8266 which is quite more 

advanced and with much more features, as the ESP-32 has in-built Wi-Fi, 

Bluetooth, and Bluetooth Low Energy(BLE). ESP-32 uses a Tensilica Xtensa 

LX6 dual microprocessor which can operate with a frequency of up to 240mHZ. 

ESP-32 microprocessor has a lot of in-built packages with a high level of 

integrations such as- 

• Antenna Switches 

• Power Amplifier 

• Low noise reception amplifier.[1] 
 

above all the mentioned information and features, ESP-32's current usage is 
less than 5µA. 
 
Some important specs of the latest ESP-32 variant which make it a more 

essential hardware component used in many projects are- 

• Integrated SPI Flash - 4MB 

• ROM - 448KB (For booting and core functions) 

• Operating Voltage- 3.3V 
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• Operating Current - 80mA(which is the average current) 

• Operating temperature ranges - from - 40 degrees to 85 degrees 

• On-chip-sensor-Hall Sensor 

Due to its amazing built in features of Wi-Fi and Bluetooth, there is no need to 

install external/separate packages which makes it a game changer in the 

market. ESP-32 allows to access the Wi-Fi Access Point and the Station mode. 

Its compatibility with the Internet Protocol (IP) such as - HTTP, MQTT, and 

TCP/IP also makes it more advanced. [1] 

 
For security purposes too, ESP-32 also supports HTTPS which makes the 

transmission of data processes more secure and well-encrypted by both end 

devices. The support is provided for various applications such as LTE, LoRa 

Modules, etc.   

 
Successful hardware like ESP-32 is also quite user-friendly as its programmed 

codes can be run in various IDE such as ArduinoIDE, PlatformI0, Micropython, 

Espressif IDF( IoT Development Framework), etc. 

 
A Mojority of the programmers use ArduinoIDE as it's more efficient and 

installing or importing packages from external sources is also quite easy.  [1] 
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Figure 1 ESP32 [1] 

2.1.1 ESP-32 Pin Layout  

The ESP-32 microcontroller IC is available with 48 pins QFN(Quad Flat No 

Leads) in Figure – 2,  package it is quite difficult to solder the IC on the PCB 

board. ESP-WROOM-32 also contains a 4MB SPI Flash IC, a 40Mhz of 

Oscillator, a PCB Antenna, and some other components for the microprocessor 

to work. [3] 

 
  Figure 2 QFN(Quad Flat No Leads) 

ESP-32 Peripheral components:-  
 

• 34 Programmable GPIOs 
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• 16 RTC GPIOs 

• 18 12-Bit ADC channels 

• 2 8-Bit DAC channels 

• 3 UART Interfaces 

• 3 SPI Interfaces 

• 2 I2C Interfaces 

• 2 I2S Interfaces 

• 10 Capacitive Touch Sensing GPIOs 

• 16 PWM Channels  

 
GPIO - The most common and important peripheral is the GPIO. In ESP-32,  34 

GPIO pins carry more than one function. [3] 

SPI - The ESP-32 Wi-Fi has 3 slots including (SPI, HSPI, and VSPI). The SPI is 

used for Flash Memory so we have two interfaces.  

I2C - There are 2 I2C pins in the ESP-32 which are assigned in pins SCL and 
SDA. If using Arduino IDE then the default pins are- 
 
SDA - GPIO21 
SCL - GPIO22 
 
Interruption - All the pins in ESP-32 are very much capable of interruption.[3] 
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Figure 3 ESP32 PinOut [2] 

2.2 Raspberry Pi 

A microprocessor which was founded in the year 2008 used to develop a 

solution with low-cost maintenance, a compact credit-size card computer that 

inspired many young coders to code and access. It's quite compatible with other 

electronic devices such as it connects easily with computer monitors, and TVs 

using a standard keyboard and mouse.  

 
Working with raspberry pi has many advantages, as it can be programmed by 

various programming languages like - Python, and Scratch. This small credit 

size computer can do everything and anything which we expect from a Dekstop 

computer. We can browse the internet, make spreadsheets, and much more. It 

has skills to communicate with the outside environment and has been used like 

an array of digital devices.  [4]  

 
Raspberry Pi was initially built for younger generations so that they could 

program and can get familiar with the hardware component. Working with 

Raspberry Pi, we can make many projects such as - home automation, building 
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strong programming skills, use for industrial applications, and much more. 

Currently, in the market there are quite a few models of Raspberry Pi which can 

be operated in an open - source environment which is the Raspbian.  

 

 
Figure 4 Raspberry Pi                                        

2.2.1 Applications of Raspberry Pi  

Raspberry Pi's main motive was to amuse people with computing, electronics, 

and programming. This microcontroller was so handy to use and it's fully loaded 

component made advanced projects have easy approaches. Some mentioned 

applications which are - 

• Home Automation - The microcontroller is so compatible with other 
devices such as relay sensors and light, smartphones, and computers. 
The operator could access the system remotely.  
  

• AI Assistant - It enables the language through its libraries from Google 
Assistant SDK, as well as Google cloud speech.   

     

• Live Bots - Live bot is a system that enables the user to handle the bots 
based on Pi over the internet. [4]   
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2.2.2 Pros and Cons of RaspberryPi – 

Pros - 
 
            Multiple Sensors:  

• Due to its multiple sensor compatibility, it can connect and support 
various sensors at a time, which motivates many electronics 
enthusiasts. 

 

• Supports all kinds of Codes - This board supports all kinds of codes of 
any language which makes it more widely used in various fields of 
technology whether it's Python, C, C++ or Java, etc. 

 

• It can also be used as a portable computer- If the user attaches a 
display/monitor to the Raspberry Pi it can become a portable computer 
and using various apps, sites and operating systems becomes 
possible.   

 

• Fast Processor - Pi has a fast processor as compared to Arduino and 
other microcontroller modules. Pi's 1.6GHz processor in its 4B 
generation, on the other hand, Arduino is integrated into a controller 
which makes Pi a much more faster and effective option. 

 

• Pi is so inexpensive and widely available that it can be used by many 
developers around the world. [5] 

 
Cons -  
 
There are some demerits of the microcontroller while using it as follow- 

• RTC - The board does not have an RTC (Real Time Clock) with a 
backup battery.  
  

• Overheating - The board is been missed out on some heat conduction or 
fan, with such a pwerfull processor and multiple features the board starts 
heating up with an average usage of 6 - 7hrs. Compact size and missing 
heating dispersion cause the board the heated up. 

  

• Not able to install Windows OS - The majority of the users use Windows 
as an operating system because windows are so user-friendly, for video 
editing and much more like software. Due to this reason, Pi has to 
compete with many counter devices. 
 

• Missing Internal Storage - The major drawback of Raspberry Pi is that it 
does not have internal storage for the device. Since uinserting, a SD 
card acts as an internal storage for the device. [5]  
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2.2.3 Raspberry Pi board Layout –  

Figure 5 Raspberry Pi Pinout [6]    

RaspberryPi 4Model B is the latest version of the raspberry pi which is much 

more advanced and with more advanced features. It was manufactured in the 

year 2019. Raspberry Pi runs a Debian - based operating system which is 

referred to as Raspbian, it is provided by the Raspberry Pi foundation.  

Raspberry Pi 4 specifications : 

USB type -C power input port.  

It has a standard 40 GPIO headers. 

It has a 64-bit quad-core processor having cortex-A72 clocked at 1.5GHz. 

It has a dual-band 2.4/5.0GHz, Wi-Fi, Bluetooth 5.0, 2 USB 3.0, and 2 USB 2.0 

ports.   [6] 
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Figure 6 Raspberry Pi - 4 

The Processor of RaspberryPi:  

Model 4 has a much more powerful quad-core Cortex-A72, 64Bit CPU running 

at a frequency of 1.5GHz, and a broadband VideoCore VI GPU running at 

0.5GHz. It can also play 4K videos and 2HDMI outputs. Adding, a fully 

functional Gigabit Ethernet interface and USB 3.0 port. [6]  

 

Figure 7 Processor [5] 
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Power Circuitry: 

The Pi uses MXL7704 which was developed specifically for Raspberry Pi. The 

chip reduces the complexity of the pi board and also produces more power to all 

the areas to run with more power. In this model many components were 

reduced, so the cost of this model also decreased.  [6] 

 

 Figure 8 Power Circuitry 

There are 40 GPIO pins in raspberry pi 4. Which includes all types of pins like 

PWM, MISO - MOSI,3V, and 5V power pin, TXD - RXD, and many other pins.  

The board also has a separate connector for the camera module and display 

module where you can attach a display of the camera to the pi board. It also 

has a headphone jack for streaming audio. [6] 
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Figure 8 GPIO Pins [6] 

2.3 Sparkfun BME688 Sensor  

The BME688 Sensor is a breakout that senses temperature, gas, humidity, and 

barometric pressure. The gas sensor on the BME688 can detect a variety of 

Volatile Organic Compounds (VOCs), Volatile Sulfur Compounds (VSC), and 

other gases such as Carbon Monoxide, this sensor calculates in Parts Per 

Billion (ppb) range. This sensor communicates via I2C or SPI, both I2C and SPI 

pins are also broken out to standard 0.1 in spaced pins. Combining it with 

precise temperature, humidity, and barometric pressure and the BME688 can 

work as a completely standalone environmental sensor all in a 1 in. x1in. 

breakout.   [7] 

 
Some important features of the BME688 Sensor: - 
 
Operating voltage range: 
 

• 1.7V - 3.6V 

• Typically 3.3V if using the Qwiic cable. [9] 
 
 
 
 
Relative humidity: 
 

• Operating range 0% to 100% 
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• Resolution: +- 0.008% RH 

• Temperature 

• Operating range: -40C to +85C 

• Absolute Accuracy: +-1.0C 

• Resolution: 0.01C [9] 
 
Pressure : 
 

• Operating range: 300hPa - 1100hPa 

• Absolute Accuracy: +-60Pa (0C to 65C) 

• Resolution: 0.01C 
 
Gas : 
 

• F1 score for H2S scanning: 0.92 

• Standard scan speed: 10.8 sec/scan 

• Sensor-to-sensor deviation: +-15% +- 15  
 
Current consumption: 
 

• 2.1 µA to 18mA 

• 0.15  µA (sleep mode) 

• 3.9 mA  in standard gas scan mode. [9] 
 

 

Figure 9 Sparkfun BME688 Sensor 
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2.3.1 Sparkfun BME688 Sensor Pin Layout  

Power:  

The BME688 sensor supplies a voltage between 1.71 to 3.6V. The power can 

be supplied to the board either through dedicated GND pins which are located 

on either side or in either one of the Qwiic connectors.  [8] 

 

 Figure 10 Power Supply 

Qwiic and I2C Interface: 

The Environmental sensor BME688 Qwiic communicates over I2C by default. It 

has routed the BME688's I2C pins to two Qwiic connectors as well as broken 

them out to 0.1.  [8] 

 

   Figure 11 Qwiic and I2C 
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Serial Peripheral Interface (SPI) 

Communicating over SPI requires more connections than I2C but it is more 

versatile and can be much faster. To communicate with the BME688 Qwiic 

board over SPI, users will need to cut the CSB and ADR jump wires. [8] 

 

Figure 12 SPI 

Solder Jumpers  

The BME688 sensor has 4 solder jumpers which can be modified to alter the 

functionality of the sensor.  [8] 

 Power LED Jumper 

The jumper connects the power LED to 3.3V via a 1k ohm resistor. This jumper 

is usually closed so to disable the LED, serve the trace between the two pads. 

This is quite helpful to reduce the total current draw of your breakout for low-

power applications.  [8] 

 

  Figure 13 Power LED Jumper          
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CSB Jumper 

This jumper applies only to the BME688 Qwiic board. The CSB pin is pulled up 

to VDDIO to configure the board for I2C communications by default.To 

communicate with the sensor over SPI, the CSB jumper must be cut along with 

the ADR jumper [8] .Once the CSB pin has been pulled low during SPI 

communication, the sensor will communicate over SPI until there is a power 

reset.    

Figure 14 CSB Jumper     [8] 

2.4 Bread board and Jumpwires  

A breadboard is a widely used tool for test and designing a circuit, with no need 

of soldering the components required. With working with the breadboard it is 

quite easy to dismantle all the components and reuse them. It consists of an 

array of conductive metal chips encased in a box of white plastic. A typical 

breadboard layout consists of two types of the region which are called Strips. 

Bus strips and Socket strips. The bus strip usually provides a power supply to 

the circuit. It has two columns, one for ground and the other for voltage. Socket 

strips are used to hold most of the components in a circuit, it consists of two 

sections each with 5 rows and 64 columns. Every column is connected 

electrically from the inside. [10]        
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Figure 15 Breadboard 

Jumpwires are simply wires that have a connector at each end, which allows 

them to connect to two points without soldering. These jump wires are used with 

breadboards and for other prototype tools, to change the circuit. These jump 

wires come in various colors but they don't mean anything all the wires are the 

same. There are two types of jump wires Male-Male and Female to Female 

wires. Male wires have pins at the end and are been used to plug with other 

components, while Female end does not and are used to plug into.  [11] 

 

 

Figure 16 Male - Male Jumpwires  [12]     
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Figure 17 Female - Female Jumpwires [12] 

2.5 MQTT   

MQTT stands for Message Queuing Telemetry Transport. It is a lightweight 

messaging protocol for cases where clients need a small code and are 

connected to unreliable networks for networks with limited bandwidth, it is 

usually used with Machine-to-Machine communications and is often also used 

with many IoT-based projects. [13]  

MQTT runs on a Pub/Sub model using TCP/IP topology. In this protocol, there 

are two types of systems: clients and brokers.  Which will be discussed in the 

following chapters. MQTT is an event-driven protocol, there is no ongoing data 

transmission, and this keeps transmission to a minimum. A client can only 

publish data when there is information to be sent, and a broker only sends out 

information to the subscriber when new data arrives. [13]    

2.5.1 Message Architecture    

MQTT minimizes its transmission with a tightly defined small message 

construction. Every message has a fixed 2 bytes of header, and an optional 

header may be used but it increases the size of the message. There are three 

types of Quality of Service(QoS) levels that allow network designers to choose 

between minimizing data transmission and maximizing reliability.  
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QoS 0 - Offers a minimum amount of data transmission. With this level, each 

message is delivered to a subscriber once with no confirmation. In this way, it is 

not confirmed if the subscriber has received the message or not. This kind of 

method is referred to as a "Fire and Forget" message or "at most delivery". This 

is assumed because that delivery is complete, these messages are not stored 

for delivery to disconnected clients that later reconnect. [13]   

QoS 1 - In this level of transmission the broker attempts to deliver the message 

and then waits for a confirmation response from the subscriber. During the 

specified time frame if the message is not received, the message is been re-

sent. Using this method the subscriber may receive the same message more 

than once if the broker does not receive the subscriber's acknowledgment in 

time. This process is referred to as "at least one delivery". [13] 

QoS 2 - The client and broker use a 4-step integration process to ensure that 

the message is received, and it has been received only once. This is also 

referred to as "Exactly once delivery". [13] 

For best communication systems QoS 0 is the best option, where the 

communications are reliable and are limited. But where the communications are 

unreliable and resource connections are not limited, then QoS - 2 is the best 

option. Using QoS - 1 provides a sort of best-of-both-worlds solution but 

requires that the application receiving the data knows how to handle duplicates. 

[13] 

2.5.2 MQTT Architecture  

MQTT protocol runs on a TCP/IP using a PUBLISH/SUBSCRIBE model. In this 

protocol, there are two types of systems- Clients and brokers. A broker is a 

server that the clients communicate with. The broker receives the 

communications from the clients and sends those communications to other 

clients. But Clients do not interact directly with each other but connect to the 

broker. Each client can be a Publisher or a subscriber. A client only publishes 



 
  27 
 

Turku University of Applied Sciences Thesis | Vinayak Chaturvedi 
 

when there is information to be sent, and the broker only sends out information 

to subscribers when the new data arrives.      

 

Figure 18 MQTT Architecture[14] 

Diagram understanding  about how MQTT protocol works with an example of 

ESP8266 Sensor.    

2.5.3 MQTT Broker  

MQTT Broker is a central software entity in the MQTT architecture. It is a 

lightweight protocol that supports the IoT. MQTT is an intermediary entity that 

enables MQTT clients to communicate. The broker receives messages 

published by clients, filters the messages by topic, and distributes them to 

subscribers. Using MQTT brokers to enable the Publish/Subscriber model helps 

make MQTT a highly efficient and scalable protocol. [14]  

  
There are two types of brokers: 
 

1. Managed Brokers   
2. Self - Hosted Brokers 

 
Managed Broker - This doesn't require the user to set up anything on your 

server to enable MQTT communication. Managed broker services allow the 

user to host their hosted brokers in their systems. The best example is - AWS 

IoT Core. 
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Self-Hosted Broker - As the name suggests self - hosted broker requires the 

user to install the broker on the user's server with a static IP. The installation 

process is quite user-friendly and is not difficult in managing, securing, and 

scaling the brokers. There are many open-source implementations of MQTT 

brokers like - Mosquitto, hivemq. [14] 

2.5.4 Mosquitto Broker    

Eclipse Mosquitto is an open-source (EPL/EDL) message broker that is 

implemented in the MQTT protocol in limited versions. Mosquitto is lightweight 

and is suitable for use on all devices from low-power single-board computers to 

full servers. MQTT protocol provides a lightweight method of carrying out 

messaging using a publish/subscribe model. This makes it more suitable for 

Internet of Things messaging such as low-power sensors, mobile devices, and 

microcontrollers. The mosquitto broker also provides a C library for 

implementing MQTT clients and the most popular mosquitto_pub command line 

for MQTT clients. [15] 

   

  Figure 19 Mosquitto Broker [15] 

2.6 Node-Red   

Node-Red is a programming tool for writing together hardware devices, and 

API's in new and different ways. It provides a browser-based editor that makes 

it quite efficient to wire together flows using the wide range of nodes and diodes 

in the palette that can be deployed to its runtime in a single-click. [17] 
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Node-Red provides a flow editor-based editor that makes it quite easy to work 

and understand the workings. Flows can then be deployed to the run time in a 

single click. A built-in library allows you to save useful functions, templates, or 

flows for re-use. Javascript functions can be created within the editor using a 

rich text editor. The flow created in Node-Red is stored using JSON which can 

be easily imported and exported for sharing with others. An online flow library 

allows the user to share the flows.   [18] 

Figure 20 Node-RED Working [18] 

2.7 PuTTy Software  

PuTTy is a free open-source software for Windows devices that gives users the 

option to transfer data securely and safely. The client uses different kinds of file 

transfer protocols such as SCP, SSH, and Rlogin to encrypt data and protect it 

from unauthorized use. The tool comes up with a Command Line Interface for 
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manipulating important functions. This program has the abilities of an SSH 

terminal so that users can easily establish a connection and send data safely, it 

also provides a Key Authentication. [19] 

This software allows the users to connect to switches, mainframes, and servers 

via SSH and serial clients. This software is quite handy, especially when 

working using the public internet. It tunnels user sessions using different clients 

like PSCP, and PSFTP. [19] 

This program uses various protocols to ensure data doesn't fall into the hands 

of hackers and is transferred to its destination without any interruptions. It's 

quite easy to configure this for network connections, we can start specifying the 

type of connection, destination, log file, and other details. The software offers 

various settings that give better control over it. As a terminal emulator, the 

program allows the user to host different operating systems on the device. 

Moreover, the software is quite useful in running Android, Unix, Mac, and IOS. 

[19] 

It is free and open-source software is quite reliable and supports a wide range 

of protocols for secure sharing and connections. PuTTy software offers many 

features which make the whole process of working becomes easy. 
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3 Implementation 

The project is initiated from the hardware side, where publishing BME688 

sensor readings (temperature, gas, humidity, pressure, and air quality) via 

MQTT with the ESP32. All the published sensor readings will be displayed in 

the Node-RED Dashboard as it supports the MQTT platform. The ESP32 is 

programmed in Arduino IDE. MQTT protocol and the MQTT Mosquito broker 

are installed on the Raspberry Pi board. An alternative way, if neglecting the 

Raspberry Pi then download the MQTT broker on your computer, for example, 

Cloud Broker.    

 

Figure 21 Thesis Project Idea 

This figure best describes the project and working of MQTT protocol. The figure 

contains BME680 sensor which is same as BME688 sensor both belong to the 

same family of sensors. 
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3.1  Schematic Design of the Project  

Discussing more in detail regarding the circuit of this project -  

The GND pin in ESP32 is connected to the GND pin in the BME688 sensor. 

The GND pin is for the output of an onboard voltage regulator. The pin can be 

used to power supply the external components. GND is a ground pin of the 

ESP32 development board.  

The GPIO 22  pin in ESP32 is connected to the SCK pin in the BME688 sensor. 

The ESP32 comes up with 2 internal I2C channels and also a default pair of 

pins for the I2C communication protocol. The default I2C pins of ESP32 are - 

SDA(GPIO 21) and SCL(GPIO 22). The SCK pin in the BME688 sensor is  

Serial Clock, it sunders the SPI interface which is compatible with the SPI mode 

"00" (CPOL = CPHA = "0") and mode "11" (CPOL = CPHA = "1"). The 

automatic selection between the "00" and "11" is determined by the value of 

SCK after the CSB falling edge.   

The GPIO pin 21 in ESP32 is connected to the SDI of the BME688. As 

discussed earlier the GPIO 21 PIN is the default I2C pin in the ESP32. While 

the SDI in BME688 is the Serial Data Input, the data input/ output is in 3 wire 

mode.  

  

                                       Figure 22 Working Circuit 
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3.2 Working details on software side  

While working with the software side of the project there are some libraries and 

software to be installed before starting to work on this project.   

Firstly, the ESP32 add-on library must be installed.  In Arduino IDE go to Files > 

Preferences. 

 

Figure 23 Clicking add on library to install ESP32 

Then Enter the following URLs into the Aditional Board Manager  

https://raw.githubusercontent.com/espressif/arduino-esp32/gh-
pages/package_esp32_index.json 

 

Figure 24 Inserting a URL for downloading the ESP32 



 
  34 
 

Turku University of Applied Sciences Thesis | Vinayak Chaturvedi 
 

Click OK! button.  

Open the Board Manager and go to Tools > Boards > Board Manager    

 

Figure 25 Selecting board from Board Manager 

Search for the ESP32 and install it by "Espressif Systems".  

 

Figure 26 Installing ESP32 by Espressif Systems 
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It might take a few seconds to install.   

 

Figure 27 ESP32 Installed 

Testing the installation process  

Go to Tools > Boards > (In my system it shows "DOIT ESP32 DEVKIT V1").  

 

 Figure 28 Selecting board for testing the installation of ESP32 
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Select the COM port in your Arduino IDE.   

 

Figure 29 Selecting COM4 port    

Open the example by File > Examples > WifFi(ESP32) > WiFiScan  

 

Figure 30 Selecting WiFi Modules 
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A new Sketch window opens up in the Arduino IDE.  

Figure 31 New Sketch windows of WiFiScan 

After the sketch opens press the Upload button, and the IDE compiles and 

uploads the board.  
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If everything went as expected then the following "Done Uploading" message 

would appear.    

Figure 32 Done Uploading 

 

Open the serial monitor at a baud rate of 115200.  

                                                    

Press the ESP32 on board Enable button and see the networks available near 

the ESP32.    



 
  39 
 

Turku University of Applied Sciences Thesis | Vinayak Chaturvedi 
 

 

Figure 33 Successfull working of ESP32 in COM4 Port  

Installing Mosquitto Broker on Raspberry Pi OS with the help of PuTTy 

software. 

 Before installing raspberry pi in windows, an SSH connection should be 

established between the computer and the raspberry pi. SSH ( Secure Shell), is 

a method of establishing communication with another computer securely. All 

data sent via SSH is encrypted and it is based on a Unix Shell, so it allows the 

raspberry pi files to remote machine by using terminal commands. This project 

is been done on the Windows platform so PuTTy is the best choice to work with. 

To download the PuTTy software browse through www.putty.org 
 
Download PuTTy it is recommended to download the putty.exe file.  
Run the putty.exe file to execute the software.  
 

 
Figure 34 PuTTy software download 

Connecting to the Raspberry Pi via SSH 
 

http://www.putty.org/
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When the PuTTy software is installed, power on the Raspberry Pi and follow the 
procedure- 

1. Open PuTTy 
2. Select the options -  

Host Name - raspberrypi (It is a default hostname). 
Port 22 
Connection type: SSH  
 

 
 
Figure 35 Selecting hostname and connection type in PuTTy software 

Click Open 
 
When using it for the first time it might prompt a warning message, just ignore it 
and simply Click, NO.   
 
Now, the user has to enter the login credentials of the Raspberry Pi to set the 
installation process. 
In the new window type the username and hit Enter. While entering your 
password, the characters won't be showing up.  
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Figure 36 Logining as pi and password 

After feeding your username and password there is a successfully established 
SSH connection with the Raspberry Pi.    
 
Now, coming back to installing the MQTT Mosquitto broker.  
 
Open the Raspberry Pi terminal window.  
 

 
Figure 37 Opening of the Terminal window of PuTTy 

Run the following command to upgrade the system:  
 
sudo apt update && sudo apt upgrade 

 
After writing the command, Press Y and Enter it might take some time to 
update. 
 
For installing Mosquitto type the following command- 
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sudo apt install -y mosquitto mosquitto-clients 

 
To make the MQTT Mosquitto Broker auto start bot the RaspberryPi and run the 
following command  
 
sudo systemctl enable mosquitto. service 

 
With this, test the installation by running a simple command. 
 
mosquitto -v   

 

 
Figure 38 Mosquitto Broker version command  

It will show the latest version of the Mosquitto broker is been installed.   
 
That's how the MQTT Mosquitto broker is installed in Raspberry Pi.  
 
Raspberry Pi IP Address  
 
To use the Mosquitto broker for future projects, having Raspberry Pi IP address 
is important, from this retrieving of data can be possible. To find the IP address 
type the following command-  
 
hostname -I 
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Figure 39 Hostname to get the Raspberry Pi IP address  

In this case, the Raspberry Pi IP address is 192.168.0.100. It’s better to save it 

for future projects.  

Now to see the data Node-RED dashboard comes into the picture, Installing 

Node-Red dashboard on Raspberry Pi. Node-RED is a powerful open-source 

tool for visual programming to build IoT applications. Node-RED runs on the 

web browser and it uses visual programming that allows the user to connect 

code blocks, which are known as Nodes. The nodes when wired together are 

called Flows.  

As established an SSH connection before with the RaspberryPi installing Node-

RED would be easy by following the command:   

 

bash <(curl -sL https://raw.githubusercontent.com/node-red/linux-

installers/master/deb/update-nodejs-and-nodered) 

Node-RED is installed by default on the Raspberry Pi OS(32-Bit). While 

installing there would be few messages informing the user, just simply enter Y 

and Enter to accept. The following messages will be to install Pi-specific nodes- 

Press Y and Enter.  Usually, it takes a few minutes to install Node-RED, in the 

end, a similar window might be on the terminal window of the user.   
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Figure 40 Installation of necessary modules of Node-RED 

After installing it is recommended to configure initial options and settings by 

entering the following command:  

node-red admin init  
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Figure 41 Implementations of Sequence for Node-RED 

After that, there would be a sequence of questions regarding how to implement, 

security, file address, the theme of the editor, and installation of external 

modules.  

Now, after the configuration of the Node-RED is completed, all the settings are 

saved on settings.js  

The start of the Node-RED is done by running the following command: 
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Program 8. Descriptive Name 

node-red-start  

 

Figure 42 Node-RED Start 

Autostarting Node-RED on boot  

To automatically run the Node-RED when the Pi boots up, run the following 

command. In this case, as long as the Raspberry Pi is powered on Node-RED 

will be running. This step saves a lot of time to restart the Node-RED. 

sudo systemctl enable nodered.service  

The access of the Node-RED dashboard can be run on port 1880. To access 

the Node-RED open a browser and type the Raspberry Pi IP address followed 

by 1880. In this project the IP address used is : 

192.168.0.100:1880 

To get the  Raspberry Pi IP address type the following command:  
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hostname -I   

 

Figure 43 IP Address 

After entering the RaspberryPi IP address followed by:1880 on the web 

browser, the user gets access to the Node-Red login page. 

 

Figure 44 Node-RED login page 

These were the process of installing Node-RED dashboard on Raspberry Pi.   
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Figure 45 Connection of Raspberry Pi and MQTT broker 

 

Figure 46 Getting BME688 readings 
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Figure 47 Connection of the WiFi 
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Figure 48 Getting readings from BME688 after regular interval 

In the above mentioned of the codes from the project symbolises the fact of how 

the MQTT broker, Node-RED is been installed in the Raspberry Pi with an 

established IP address. Following to it in the code all the measurements are 

been specified to get an adequate data with correct scientific units. The code 

also describes the connection of the WiFi with the BME688 sensor, where the 

connection can be established and disconnected. In the last part of the code , Is 

the section were the code is programmed to get all the readings from the 

sensor.Publishing of the data in the Node-RED dashboard to get a proper visual 

of the sensed data. 
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4 RESULT   

After the completion of the thesis project, the goal is achieved by showing the 

data communication using MQTT with the BME688 sensor. Below in figure 49, 

the observation can be made that the BME688 sensor is sensing the data 

accurately and publishing it in the serial monitor of the Arduino IDE. Where the 

sensor first connects to the Wi-Fi and then shares the IP address through which 

we can access the node-Red dashboard for better data visualization. Following 

it, the temperature, humidity, pressure, and gas data can be shown and lastly, 

the MQTT acknowledges the publishing of the data.   

 

Figure 49 Serial monitor result published   
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In figure 50 observations can be made regarding how the connection is made 

and showing how the Node-RED dashboard virtually connects the components 

and subscribess back the data to the user. 

 

 

Figure 50 Node-RED Connection 

Lastly, a distinct image of the complete circuit which is been in use for the 

implementation of the project. The ESP32 is powered on and the connection 

with the BME688 sensor with the specific pins through which all the data is 

been sensed is the goal of the thesis project. Raspberry Pi is also in action 

where it is responsible for the installations of the software which is the Node-

RED and Mosquito Broker. 
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Figure 51 Circuit implementation 
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5 CONCLUSION  

The main idea of this thesis is to show the data communication using MQTT 

with BME688 sensor Gas AI sensor developed by BOSCH. The BME688 

sensor is so well equipped that sensing gas, pressure, humidity and air quality 

data becomes possible to achieve. Transmitting the data from the sensor with 

ESP32 microcontroller programmed in Arduino IDE, as installing all the 

necessary libraries and modules becomes easy to handle. The thesis project is 

obeying a certain and most important protocol, MQTT-  which is mainly used in 

IoT projects and also helps the messages to be encrypted as the data 

transmitting is not in high quantity. After all the data has been sensed from the 

real environment, it is displayed in the Node-RED dashboard. Node-RED is a 

very powerful open-source for developing IoT applications. It runs on a web 

browser and uses a virtual programming experience which allows the user to 

connect with the nodes. The MQTT Broker(Mosquitto) is installed in Raspberry 

Pi and also the Node-RED dashboard.The results achieved is also success , 

the BME688 was able to send the data. To communicate with the Raspberry Pi 

via SSH PuTTy software was been implemented to install, PuTTy uses SSH 

connection as a method of establishing a communication with another computer 

more securely. All the data sent via SSH encrypted and also PuTTy also allows 

to access the Raspberry Pi files from a remote machine by terminal commands. 
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